High Definition Intelligent IR
[P Auto-tracking Speed Dome Camera

User’s Manual
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Chapter 1 Precautions

In order to avoid danger and operate the products correctly, please read this manual carefully
before installation.

The precaution contains two parts “Warning” and “Note” as following:

Warnings alert the user to avoid Cautions alert the user to avoid the

the potential risk of death or serious | potential risk of injury or property

injury damage

arning:
e Please use AC 24V power supply meeting SELV(Safety Extra Low Voltage) and in accordance with
IEC60950-1 compliance with Limited Power Source
e Please contact nearest distributor or service center if the products don’t work properly, do not
remove or modify the device in any way (unauthorized modification or repair problems caused by
your own risk).
e Please don’t expose the indoor product to rain or moisture.
e The installation should be performed by professional staff, and comply with local regulations.
e Please mount easily using power protection device in the wire installation.

e Please make sure the connection can withstand at least 50 Newtons vertically downward pull.

Note:
e Please check if the power supply is correct.
e In transportation and storage process, please prevent stress, severe vibration and immersion to
avoid any damage
e Please don’t touch the image sensor and housing directly, if necessary, please gently clean with
alcohol dampened.
e Please don’t touch the cooling components directly, in order to avoid burns.
e Please don't focus aligned glare (such as lighting, sunlight, etc.), otherwise it will easily lead to
too bright or pull light phenomena, also affect the image sensor life.
e The laser beam may burn the image sensor, so when it is used, please don’t expose the image
sensor in laser beam.
e Please don’t put it in the damp, dusty, extreme heat, extreme cold, strong electromagnetic
radiation places.

e Please make sure the installation location keep enough distance from the electromagnetic
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sensitive devices surrounding to avoid electromagnetic interference.

e Please prevent heat buildup and keeping the surrounding ventilation.

e Please prevent the speed dome from water or any liquid.

e The product must be carried by original package, either in delivery to users or in return delivery

to the factory for repairing. Otherwise, damage caused in transportation will not be covered by

warranty.

e The battery replaced incorrectly will lead to use of exceptions, and we don’t recommend users to

replace directly; If necessary, please use batteries recommended by the manufacturer (for devices

with battery).

e Please don’t dismantle internal parts, please turn to qualified maintenance professionals to carry

out repairs

e Long-term high speed cruising may cause slip rings broken and belt aging, also affect speed dome

life.

e Working Environment

Speed Dome

Environmental temperature

-40°C~+65TC

Moisture <95% (Non-condensing)
Atmospheric pressure 86~106KPa
Power AC24V/2.0A

Note: make sure outdoor installation meets water-proof requirements.




Chapter 2 Structure
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Chapter 3 Functions Description

3.1 Features

1. Built-in Decoder

e HD IP Speed Dome, support 720P 25/30fps or 1080P 25/30fps output.
e Support English menu

e Support standard Onvif

e Power-off protection, no data loss

® RJ-45 port network port

e Support PELCO_P,PELCO_D protocols.

e Support 3D location

e Support standby function

e 225 programmable presets

e 8 cruising tracks, each cruising track has 32 preset positions
e 8 auto scan tracks, the left and right boundaries and scan speed can be set
e Support OSD, date and time display

e Support 1 channel alarm input and 1 channel alarm output
e Support TF storage and local capture

2. Integrated Universal Speed Change Rotator

e Manual Speed:0.05°~160°/s, Max speed 240°/s

e 360° continuous pan rotation, tilt -11°~90° auto flip

e Stepless speed change, auto zoom/speed matching

e Classic double bearing structure, more stable operation

e Delicate stepping motor, stable, sensitive and accurate

3. All-weather Outdoor Design

e Sensor intelligent control

e Double housing structure

e [P66 water proof

e Support anti- lightning and anti-surge



4. Camera Module

e Support auto iris, auto focus and auto BLC

e Mini. [llumination 0.5Lux/F1.6(color),0.095Lux/F1.6(B/W)

e Support 3D noise reduction and WDR

5. Network

e Support Ethernet control

e Support remote view and control by browser and client software

e Support Micro SD card

e Support NFS

e Support remote view and control by browser and client software

e Support Micro SD card

e Support for NFS record

e Support four levels user authority

eSupport for authorized users and passwords, support HTTPS encryption and IEEE 802.1x
network access control

e Support dual-stream, support H.264/MJPEG, support multi-level video quality configuration,
and support real-time video output resolution 1080p, 960p and 720p

e Support multiple network protocols, IPv4/IPv6, HTTP, HTTPS, 802.1%, Qos, FTP, SMTP, UPnP,
SNMP, DNS, DDNS, NTP, RTSP, RTP,

TCP / IP, DHCP, PPPoE

6. IR Function

e Mini. [llumination 0Lux

e Adopt array IR, low consumption, IR distance 150m

e IR LEDs and zoom auto match

e Support NFS

o Built-in heat treatment and defog systems

e Constant current circuit design, IR LED life >30,000 hours



3.2 Function Instruction

e Focus/Rotate Auto Match

Speed Dome can auto adjust pan and tilt rotation speed depending on the focus distance.

e Preset Position Setting and Calling

Preset function means the speed dome can memory current pan/tilt angel, focus, zoom, ect. When

need, it can be called upon directly. Our speed dome support up to 255 preset positions.

e Auto Scan

Users can set the left and right boundaries by control keyboard. Then speed dome can scan

between it. It can set up to 8 groups scan path.

e Auto Cruising

Users can program some preset positions into auto cruising sequence, then the speed dome can

track as it. Each cruising tracks has 32 preset positions.

e Pattern Tour

Speed Dome can memory 180s running path. When start pattern tour, speed dome can track as

recording path. It supports 4 groups pattern tour.

e Guard Location

The dome will rotate back to preset position after a period of vacant time.

e Power-off Protection

Speed dome can resume operation status before the power-off, no data loss.

3.3 Specification

Model
HD IP IR Auto-tracking Speed Dome
Specification
Sensor 1.3M:AR0130-1/3” CMOS 2M:IMX222-1/2.8” CMOS
Camera Pixel 1.3M 2.1
| Resoluti Color:0.5 Lux @ (F1.6,50 IRE,ICR close)
mage Resolution B/W:0.095 Lux @ (F1.6,50 IRE,ICR open)




Resolution 2720TVL 21000TVL
White Balance Auto / Manual/ATW
GC Auto /Manual
S/N >50dB
Noise Reduction 3D&2D
WDR Support
Electronic Shutter 1/25---1/10000s
Day/Night Auto ICR
Focus Auto / Manual
Focal Length 14.7~84.6mm,20X 4.7~94mm,20X
Zoom 3S
Lens Horizontal Angle 54.8°-3.4° 55.5°-3.0°
Near Distance 20~1000mm
Iris F1.6 ~F2.7 F1.6 ~F3.0
Horizontal Rotation
360°continuous rotation
Range
Horizontal Speed 0.05°~160°/s (stepless speed)
Vertical Rotation
11°~90°auto flip
Range
Vertical Speed 0.05°-120°/s
Preset 255
PTZ

Auto Cruise

8 group, each group can set 32 preset

Auto Scan

Support track, horizontal, vertical, frame, whole view and

random scan

Guard Location

Link preset/scan/cruise/pattern

Power off Memory

Support

Position

Information Display

On/Off




IR Distance

150m

IR
IR Angle Zoom matching, far/middle/near
Image resolution 1280%960 1920x1080
50Hz:25fps(1920x1080)
50Hz: 25 fps (1280x960) 25fps(1280x960)
25 fps (1280x720) 25fps(1280x720)
Frame rate
60Hz: 30 fps (1280x960) 60Hz:30fps(1920x1080)
30 fps (1280x720) 30fps(1280x960)
30fps(1280x720)
Video Compression H.264 /M]JPEG
Network Audio Compression G711A/G711U/G726/ADPCM/AAC
IPv4,HTTP,HTTPS,802.1%x, FTP,SMTP,UPnP,SNMP
Network Protocol
DNS,DDNS,NTP,RTSP,RTP,TCP/IP,DHCP,PPPoE
Preview Channel Max 6ch
Stream Triple
) 32 users, 4 level: administrator, browse, browse+control,
Authority
browse+control+setup
Authorized user name and password, HTTPS encryption;
Safe Mode
IEEE 802.1x network access control, IP address filtering
Audio Input Support
Audio Output Support
Network 10M/100M
Interface
TF Card Support
Program Support standard Onvif
Browser IE8,IE9,JE10,Chrome8+,Firefox3.5+
Power AC24V 40W max
Working
-40 C-65C
Temperature and L
Humidity<90%
Humidity
General

Protection Level

IP66,TVS 4000V lightning protection

Dimensions

®230 (mm) *350 (mm)

Weight

4.8kg

10




Chapter 4 Installation Guide

4.1 Preparation

1. Tools:

Please prepare the necessary tools according to specific situations

Cross Screwdriver(small)
Shifting spanner /

Straight screwdriver Allen wrench(4mm)
4 (large/small) g

2. Check installation space and address

Check the space is enough to install the speed dome. The wall must be thick enough to install the
expansion screws and can bear 4 times the weight of the dome camera itself.
3. Please well keep the whole package

After open the package, please well keep them in case need to return to manufacturer if any
problem.

% Note:The non-original package may lead to damage during the transportation.
4.2 Installation

The speed dome supports four types installation as following:

1:Wall mount and dimension:
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109 258

139 163

Wall Mount Bracket Dimension

2:Pedant mount and dimension:

Clo

=

Pedant Mount Bracket Dimension
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3:External corner and dimension

85

139 164

M8

176

120

External Corner Bracket and Dimension

4:Pole mount and dimension:

120

139 165

M8

Pole Mount Bracket and Dimension

13



4.3 Interface Instruction

™

39

7’9

8'0T

Speed Dome and Bracket Interface Dimension
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Speed Dome and Bracket Interface Perspective Picture

4.4 Installation Procedures (Take Wall Mount as Example)

A

— Bracket

Housing

Cover

Figure 1
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Figure 2

Steps:

Remove the wall mounting bracket and speed dome, and lead the cable through the bracket and
set aside to the right position. Aligned the screw holes of speed dome to that of bracket, and use
M6 screws to fix. (as Figure 1)

Mark the drill holes position on wall with ink pen for bracket installation, then drill holes and punch
the expansion screws in, then fasten the bracket with M8 screws as Figure 2.

Description:

1) The wall must have sufficient load-bearing capacity.

2) Outdoor installation shall be completely sealed moisture; leads cable should closely along the

bracket wiring as Figure 1.
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4.5 External Cable Connection Instruction

Al

A1l: Power Cable:AC/DC24V;

A2: Network: Connect computer or other devices

A3: Audio Cable: Audio input and output can connect mic and speaker

A4: Alarm Cable:Connect external alarm devices;

T
/
I ——— Power (AC 24V)

“Network

Note: Please refer to labels on the cables
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Chapter 5 WEB Instruction

5.1 System Requirement

The IP speed dome web settings support Windows XP, Win7 system, please make sure right
installation and setup of following items:
(1) Display resolution: 1024 * 768 or higher, color: High Color (32-bit).

(2) Please make sure the Windows system install the necessary character style.
5.2 Built-in Web Instruction

When using the network video products for the first time, an ActiveX control is needed. Note: please
use IE browser of windows and make sure the version above 6.0. Do not use any other browser
except Firefox, Google.

(1) Login IP address and enter to ActiveX download interface.

(2)Download ActiveX and click [Run] to install

5.3 Login
Camera default IP address is:192.168.1.2,please make sure computer and IP camera in the

same IP address area.

You need to download Active X plug when first time to use.

NETVIDEO English v

User Name |admin

Password @0 0®@
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5.4 Preview

Descriptions of live view page

Menu Bar

201907707800 S04 . < Channel 1 oy
: o
v .

- #— PTZ control
-3
~~ i
Live view windows -t
S
a

— Preset
Live view|parameters — = i | ' | == [—Video Parameters

5.4.1 Live View

Channe1 1
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Descriptions of live view parameters and toolbar

Icon Description Icon

Description

Major stream
Major B

Manual recording on / off,
and default storage path is
D\NetVideoBrowser\

Minor stream

Manually capture, and

Miror =3
Ay default storage path is
D\NetVideoBrowser\
Third stream a Intercom on/off
3rd Stream g
Screen lock K_a Full screen
P -,
o Screen adapt to current o Audio on, volume adjustment

resolution

and mute

Note When stream type is [ Pure Video] ,audio preview is invalid.

5.4.2 Video parameter

(1)<Default> to resume the default settings.

(2)According to network situation you can choose preview mode
from <Low bandwidth>, <Low latency> to <High quality>,

<High fluency>

5.4.3 PTZ control

(1)Select rotation direction of speed dome,

O

' enable auto scan.

(2)<Zoom>Zoom in /Zoom out
(3)<Focus> Manual Focus.

(4)<Iris>Manually adjust iris.

(5) set PTZ speed  __ +

© <
(7 O » Preserved for future functions

' a%

, HLC: , WDR:

Wipper

(8) Defog:

20

¥ideo Faram <
.:",:. (} 30
O (} 30
i
w . a0
* (} 28

Default

v . b |

() Low bandwidth 3 High quality

i Low latency () High Fluency

4{_}»

[N v 4

-— Zoom +
— Focus +
-— Iris +
0 # <




Freset Lol

5.4.4 Preset position

2
s
Search the target preset number _
Preset 2
<Set> Setup preset position
PP p Preset 3
<Call>Call the preset position Presst 4
Preset 5

5.5 Playback

“« 2014-02 ’ow
Sun | Mon| Tae | Wed [Thu [Fri |[Set

z 3 4 5 & 8
9 |0 |1t | iz |13 | 14 | 15
6 | 1m |18 |18 | a0 |a1 |2

23 | 24 |25 |2 | o1 | =

FileType [Record v

RecType | Al ~ | Remate [¥]

Chan No. Start TimeStop Time

<

>
" o« » o L I A @ N | W | [ | e oomopoonm 4= = LR

5.5.1 Search recording files -
“Wod 201402 [
Sun Maom Tua Kad Thu |Fri Sal
(1)Select date in the calendar .
(2) <File Type> select <Record> or <Picture> : 1-n :1 ° I: F ;
(3)<Rec Type> Select targeted file type video/picture. L R U
23 21 & 2B 21 26
FileTyps Racord L
RecType Al %  Remrole [¥]

Chan Mo, Start Time Stop Time
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5.5.2 Descriptions of playback toolbar

con Description Icon Description

Stop recordin Clip video files, and default
® p g -\a p -
—_— storage path is
D\NetVideoBrowser\
Speed down in Singl
4 p ) gle screen
1/2X,1/4X,1/6X and 1/8X e
Play Playback in 4 screen at the
2 H .

i S same time

Speed up in 2X,4X,6X and 8X X2 Full Screen
» I..
Playback by frame Download recording files
I» L ]
i Audio on, volume adjustment T Download files into FTP
= and mute 5 server
© Capture, and default storage _!g Preview download status
VS path is D\NetVideoBrowser\ ]
5.6 Log

(1)<Channel No> Select target channel
(2) <Log type> e
All/system/warning/alarm/operation/user/others - w . oo e Zm
(3) <Start time> Select start date and time.

(4) <End time> Select end date and time.
(5) <Query> Get a log list.

Live View Flapback " Configuration

(6) Check logs by <First page><Pre page><Next
page><Last page> and <Jump to>target page.
(7)<Export current page> to export logs, and default

save path is D\NetVideoBrowser.

e [pefoe | [ietrce | (Latpge | Tta0Poe s wsto v Exprt et | [ ot P

(8)<Export all page> to export all the pages query,
and default save path is D\NetVideoBrowser.
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Chapter 6 Configuration

Audio Param

Key Region
» Dome Set
b WCA
b OSD
b Starage Management
P Metwork Managemert
P User Management
b Alarm Management
¥ PTZManagement

b Advance Set

video Param

Chanmnel No.
| GeneralSet
Yiden Qualty
Stream Type
Resolution
Bit Rate
Frame Rate

Prefer Mode

[ channel 1 magor

|stter

[ udio video

|asap(1 280060

‘5144

25

|Frame Rate

HiPMods  |PAL v

IFrame Rate |5n ‘

Encodng Mode | stati code rate v

| Advanced Set

[ save ][ mport | [ Expot |

Attention: All settings will be enabled in 3 seconds after <save>.

6.1 Audio Video Set

6.1.1 Video Parameter

<Channel No.>Select the target channel

General Set

(1)<Stream Type><Audio Video>/<Pure Video>
(2)<Encoding Mode>

<Static code rate> Fix stream and bandwidth
occupation.

<Dynamic code rate> Stream will be varied to the
change of video, take up less bandwidth when there is
no change on video.

(3)<Video Quality>only be activated when choose
<Dynamic code rate> in <Encoding Mode>.

<Video

Quality><Best>,<Better>,<Good>,<Fair>,<Poor>

~ Audio Video Set

Audio Param

Key Region
¥ Dome Set
b uCA
b 05D
P Storage Management
b Nebwork Management
b User Management
P Alarm Management
¥ PTZ Managemert

b Advance Set

Video Param

Channel Mo,
| General set
Viden Quality
Stresm Typs
Resolution
Bit Rate
Frame Rate
Prefer Mode
NP Mode
TFrame Rate

Encoding Mode

_b| Advanced Set

[ channel 1 major

[Better

[ Audio ide

| s60p(1260x960)

‘5144

25

[Frame Rate

‘ PAL

[so

[ static cade rate

(s ) [ ) [(pemn

The better quality the more stream and bandwidth occupation.

(4)<Bit Rate> show stream rate for the video, unit is Kbps. When choose<Static code rate>, <Bit

Rate>stand for actual rate of the stream. When choose<Dynamic code rate>,<Bit Rate>show

the max stream rate, range from 32 ~ 8000Kbps.
(5)<Frame Rate> 1/5/10/15/25/30fps optional.

(6)<I Frame Rate> To set the interval time for each two I frame. (I frame is the key frame in the

video stream)
(7)<Prefer Mode>
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<Frame Rate> Fluency first

<Quality> Video quality first

(8)<Resolution> 4CIF/VGA/720P/960P/1080P.
(9)<N/P Mode> Select <PAL> or<NTSC>.

Advance Set

(1)<Video Encoding> < bt o5
<H.264> and <Motion JPEG> e
(2)<Extended Code> P
Available when selected <H.264>, there are :ZCS:
<baseline>, <main profile>, <high profile> for :eri:zzzmm:i
selection. : P
(3)<Encrypt Type> Add password for the s
channel.

<Encrypt Password> Enter password.

<Password Confirm> Confirm the password.
Click<Save>to enable.

¥ideo Param

Channel tia.
| General Set

%] Advanced set
Extended Code
video Encading
Channel Type
Encrypt Type
Encrypt Passuord
Passuword Confim

Electronic image stabiization

Chanrel 1 Major

baseline

H.Ze4

Mot encrypted

Disable

Video Parameter-Export

<Export> backup the configuration file, save to
D\NetVideoBrowser\VideoParam.dat as default.

Video Parameter-Import

<Import> import the backup file for parameter configuration.

Audio Parameter = o Vi et
Yideo Param

(1)<Channel No.>select target audio channel. o poran

Key Region

(2)<Audio Encoding> select audio compression

¥ Dome Set:

[

type b 050
(3)<Audio Sample Rate> ¥ sroregs enagemert
¥ Hetwork Management
<8k>,<32k>,<64Kk> optional. [T—
¥ Alarm Management
(4)<Save> save and enable the setting. b P12 Monagenent

b Advance Set

Audio Param

Channel Mo, | Channel 1

Audio Encoding |G, 7118

audio Sample Rate  |gk

Save

Note: some models need reboot after saving the

setting.
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6.1.3 Key Region

<Key Region> To have better image quality
for some regions on the video, there are 4
regions settable for each video.

(1) <Draw Region>

Use the mouse to draw the key region on the
video.

(2)Click<Save> to enable.

(3) <Delete Region>

delete the drawn regions.

6.2 Dome Set

6.2.1 HD Parameter

Set video image parameter in this page.
HD Param-Model

The system provides 8 video templates for

different application, all the video parameter

can only be revised and saved in the template.

(1) <Current> Select current template.
(2)<Name>show the name of the current
template, it can be revised.

HD Param-Parameter

(1)<Image Adjustment>

Sharpness range from 0 to 255.
(2)<Exposure Setting> Auto/Manual.
(3)<Focus Setting> Auto/Manual.
(4)<Day/Night Switch>

<SmartIR>  On/Off

<Day/Night> Auto/Night/Day
<Sensitivity> Low/Middle/High
(5)<Backlight Settings>

<Wide Dynamic> On/Off

<Level> Low/Middle/High

(6)<White Balance ><Auto><Manual>and<ATW>.When selected<Manual>,there will be 2

Key Region

Chamelfo.  Channel 1

Current  |wdr
Mame  |wdr
w Image Adjustment
Sharpness
} Exposure Settings
)| Focus Settings
¥/ Day/Might Switch
¥ | Back Light Settings
#| White Balance

}| Image

Save

Defaults

Import

sliding blocks to set the white balance, R stand for red gain and B stand for blue gain.

(8)<Image>
<Light Suppression> On/Off
<Defog> On/Off
<Digital Denoise>

<Denoise Level> range from 1~255

Close/Ordinary Mode/Expert Mode

Export



HD Param- Defaults
Click button< Default>to recover the defaults setting for the target template.

Remark <HD Param> has Export and Import function, operation is the same as <Video Param>.

6.2.2 HD Schedule st
S —
Camelfle. | chrrel!
To define different video template used for et g e
o oo
different time period. — o e
SasH o st
(1)1t offers 8 different time periods, select the o . —
. s - —
check box to enable it. (S - -
. . [yT— - —
(2)Select template for each time period. Vst 5
» skt g g e st e gtz e
(3)Length of each time period is settable. Colors e
¥ Aance 5t
are different for different template. v . o .
. it o mion L s it 1erastn
(4) Click<Save>to save and enable. e [
6.2.3 Basic Set
. P Audio video Set
6.2.3.1 Basic r—
HD Param
<Auto Flip Enable> Enable for 0~180°, disable 0 scecle Cramet o, [Charnel
s | Basic
for 0~90°. Metion Set ] Auta Fip Enable
Motion Schedule
<Tilt Angle Adjustment> Set the tilt angle for T fodepsent |2
Status Info Control Speed | middle
speed dome camera, range from “0”to“-11 v R
degree. » Storage Management futo Stop-time(s) [0
b Network Management Prosst Speed iah
<Control Speed> T - " L
¥ Alarm Managemenk andby Action Enable
Set limit for the max operation speed, » prepusomore Sy Tl
» Advance Set
high/medium/low for selection, high=240°/s,
. | Tl
medium=160°/s, low=80°/s.

<Auto Stop-time (s)> Set the time period for the
speed dome camera to stop PTZ movement
since the last operation. It can be set to be
5/15/30/60s.

<Preset Speed> Set the preset speed for speed dome camera, there are high/medium/low for
selection.

<Temperature Control Mode><Auto>and<OFF>

<Standby Action> It is to define the action of speed dome camera when it is idle. There are 4
options preset#1, scan#1, cruise#1 and pattern#1.

<Standby Time (s) > enable standby time setting. There are 30s,60s,300s,600s and 1800s for
selection.

<save> save and enable all the setting.
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6.2.3.2 Title

» Audio video Set
= Dome Set Basic Set
<Title Type> Preset, Scan, Cruise, Pattern and D Schecic Cherreito.  [<hannet 1 -
Basic Set ] Basic
Zone No. o
Motion Schedule
<Title No.> Preset number range from 1-32, - mjw : v:
Scan number range from 1-8, Cruise number e THonane (B0 |
¥ Storage Management Stay Tme (55 <
range from 1-8, Pattern number range from 1- [P — ' D o
¥ User Management
8, Zone Number range from 1-8. » Al anocemer [lossiay e ssdaround
¥ FTZ Management
. :
<Title Name>Set title name. e st
<Stay Time> Title display on the screen,
options 2s,/5s/10s/disappear/keep.
<Display Coordinate Direction> check to
display the movement coordinates.
<Display Title Background> check to display title background.
6.2.4 Motion Set
b Audio Video Set 2.
w Dome Set Maotion Set
HD Param
HD Schedule Channel No. Channel 1 v
Bak ot O 20 - Soar | o os t N al
Motion Schedule ’ |
IR Set
Seatus Info CriseNo. | v cal
P NCA Crusse 12
» OS50
» Storage Management Presat 1 v
» Network Managamert. Stay Tre(s) || &
b Usee Managemnert
¥ Alarm Management
ScanMNo. | v Call
» PTZ Management —_—
¥ Advance Set ScanType  Pan Scan v
ScanSpesd 20 v
Broder1 | [ Broderz
Pattern No, 1 v cal
Used(%) — v
6.2.4.1 Preset
<Preset No.> Speed dome camera supports
220 presets, number range from 1-64 and | I
Presstho. |1 i Call
100-255.
Focus Mode |.ﬁ.ut0 v|
<Focus Mode> Focus mode for preset can be [ X
Set Delete

auto/manual.

<Set> Move to target position and press

<Set> to save as preset position.

<Delete> Delete the target number of preset position.

<Call>Speed dome camera will move to the target preset position.
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6.2.4.2 Cruise

<Cruise No.> Speed dome camera

supports 8 cruises, number from 1-8 CruiseNo, |1
<Cruise> show how many presets in the Cruiss |12
cruise. procst |1
<Preset> Only preset number 1-64 and Stay Tme(s) |1
100-255 are available, click <Add> to add | [ Delete

add the preset into cruise list.
<Stay Time(S)>Set interval time
between two presets, rang from 1-60 seconds.
<Add>Add presets into cruise list.
<Delete>Remove preset from the cruise list.

<Call>Activate the speed dome to move follow the presets in cruise list.

6.2.4.3 Scan
<Scan No.>The speed dome supports 8

S Mo,
Scans, number from 1-8 can b |1
Sean Type  |Pan Scan
<Scan Type>Pan Scan, Auto Scan, Frame
Scan Speed |20

Scan, Random Scan, Tilt Scan and

Broder 1 ] [ Broder 2

Panorama Scan.
<Scan Speed>Set speed for Pan Scan, Auto

Scan, Tilt Scan and Panorama Scan.
<Border 1>Left border of the Scan.

<Border 2>Right border of the Scan.
<Call>Activate scan movement of the speed dome.

6.2.4.4 Pattern

<Pattern No.>The speed dome camera

supports 8 pattern tour, number range Paitern No. |1

from 1-8.

Used(%) —

Left Timeds)

<Used(%)> Show percentage used for e (oo

operations in one pattern tour.

<Left Time(s)> Show the time remaining

in the pattern record process. (The speed dome camera supports up to 180s)

<Record> Start pattern tour recording

<Delete> Delete the target pattern.

<Call> Activate the speed dome camera to move following the pattern tour.
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6.2.4.5 Zone No.
<Zone No.>The speed dome camera

supports 8 zones, range from 1-8.
pp ’ g Zone Mo, |1 b

<Left Border> Move the speed dome ,
Left Broder ] [Rnght Broder] [ Delete

camera to the target position and

set it as the left border of the zone.

<Right Border> Move the speed dome camera to the target position and

set it as the right border of the zone.

<Delete>Delete the target zone.

<Set Origin>Move the speed dome camera to the target position and set it as original point of
the coordinate.

<Set North>Move the speed dome camera to the target position and set it as north direction of

the coordinate.

6.2.5 Motion Schedule
Activate different motion (Presets, Scan, Cruise and Pattern) for different time period.

b Audio Videa Set
v Dome Set. Motion Schedule
HC Param

HD Schedule Schedde | Friday v [lEnable

Basic Set Stark Time End Time Action Action Mo,

Mation Set

IR Set
Status Info

» HCA

» 05D -

» Storage Management ~

¥ Network Management

¥ User Management

} Alarm Management
CopyTo  [Jal

Osun Cron [Tue Cwed  [Jthu Fri Osat Apply

¥ PTZ Managemenk

b Advance Set

<Enable> Enable the setting.

<Start Time>Start time for the motion.

<End Time>End time for the motion.

<Action>Motion in this time period.

<Action No.>Motion number, Preset 1-8, Scan 1-4, Cruise 1-4, Pattern1-4.
<All>Enable every day in a week, including Saturday and Sunday.
<Apply>Click to copy the configuration to the selected day.

<Save>Save all the setting.

29



6.2.6 IR Set

» Audio Video Set

v Dome Set IR Set
HD Param
S ChannelNo. [Channel 1 v
Basic Set T Control Mode | Manual Close v
Motion Set -
Motion Schedule Zoomvath [on ]
. Near Lamp Brightness  ©
Status Info
» vea Far Lamp Brightriess |0
» 0sD
» Storage Management e
» Network Management
» User Management
» Alarm Management
» PTZ Management
» Advance Set
<Control Mode>Auto, Manual Open, Manual Close.
<Zoom Match>When it is ON, the brightness and power
consumption of the IR LED will be matched with the camera
zooming distance automatically.
<Near Lamp Brightness> Disable zoom match, set the Near
lamp brightness level, range from 0 to 10.
<Far Lamp Brightness> Disable zoom match, set the far lamp
brightness level, range from 0 to 10.
<Save> Save all the setting.
Smart IR group, 150m IR range at night
6.2.7 Status Info [ap—
It shows current status information of speed - stonusnfo
- HD Sthedule Release Date  2014-01-14 17:14:12
dome. e 5o P—
Mokion Set
‘- Mation Schedule Pantimi K
-~ IR et Tilt Limit 0K
Interface  OK
L)
» OSD sensor - OK

¥ Storage Management Tomperature 297
¥ Network Management
b User Management
b Alarm Management

¥ PTZ Management

b Advance Set
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6.3 VCA

VCA(intelligent video analysis) includes 11 functions:

Tripwire Perimeter Items Abandon Items Lost

Loiter Running Crowd Parking

[l
=

Notes: Tripwire and Perimeter are able to activate auto-tracking.

CAUTIONS: To enable the VCA functions, please DO follow the steps:

1.Scene Set—2.Alarm Set—3.Advance—4.Cruise Set.

Specify detail operation of VCA in <Scene Set>, then setup VCA alarm schedule in <Alarm
Set>, enable <Advance>, finally setup activated time for each VCA rules in <Cruise Set>.
PLEASE DO NOT MISS ANY STEP ABOVE TO AVOID ANY FAILURE OF SETTING.
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6.3.1 Alarm Info

This page is just used to display alarm info when you success to configure.

<Reset>Clear alarm numbers of the VCA rule.

<Clear>Delete all the alarm information in list.

Alarm Info

Channel No.  [Channel 1 -

| Alarm Time Chan No. Scene Num... Rule ID Event

Alarm Capture Images

6.3.2 Scene Set

<Behavior Analysis> check to enable
behavior analysis, including Tripwire,
Perimeter, Items Abandon, Items Lost,
Loiter, Running, Crowd, Parking.

Notes: If check <Linkage Tracking>, it
will allows Tripwire/Perimeter to
activate auto-tracking.

<Save Scene> click to activate settings.
<Rule ID> make the rule numbers for
behavior analysis. Support up to 8 rules
in the same scene at the same time.
<Valid> activate the rules and start

setting.

Scene Number

Scene Mame

Enable Arithmetic

Arithmetic

Rule ID

Rule Mame

<Rule Name>Give a rules name(max to 16 characters).

<Rule Clear>clear current rule.

6.3.2.1 Behavior Analysis

Scene Number

oN

Algorithm Type [Behawor Analysis

v) [ Reset |

RueD |1

Rule Name

1 ~]
Outdoor
Behavior Analysis [ | Linkage Tracking [T Face Detection
|| pemographics
[Behavior Analysis v]
(2 -] [Fvaiid
Rule Clear
RueD 1 =] Dlvaid
Rule Name
Event Set [Tnpw\re vl [ Line Clear ]

Alarm Color

No Alarm Calor

Below are setting operation for different type of analysis

after Selected <Behavior Analysis>:

(1)Event Set --- Tripwire/Perimeter
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[ Show Alarm Count
[T show alarm Rule
[ Two-way Alarm

Save



<Detect Mode> For <perimeter> detection, include
<Intrusion>/<Enter>/<Leave>.

<Intrusion> alarm when object come in/out.

<Enter> alarm when object come in.

<Leave> alarm when object go out.

<Show Alarm Count>show total alarm times.

<Show Alarm Rule>show defined tripwire/perimeter on video.
<Two-way Alarm>when selected <Tripwire>, choose the"two-
way alarm”, then two directions cross will both trigger alarm.
<Line Clear>clear current lines drawn on video.

<Rule Clear>clear current rule.

<Save>Save and enable the VCA setting.

<Linkage Tracking> or <Panorama Tracking>

Tips: <Linkage Tracking> option is only available when you
check <Behavior Analysis>

< Arithmetic > configure <Intelligent Tracking>

<The longest> Set time limitation (seconds) how long the PTZ
follow the object. And then it will go back to standby position.
<Speed Dome> Enter the value how high (meters) you install
the PTZ

<Static Tracking> Set time (seconds) when the object stay for a
while, the PTZ will go back to standby position

<Limit> Setup boarder of traking area from 4 direction. When
the object go beyond the area, PTZ will stop to follow it.
<Enable Limit>Check to activate traking area boarders

<Enable Anti-blocking>PTZ wil alarm when it is blocked

(2)Event Set ---Items Abandon

Event Set

<Line Clear>remove the defined area on video.

Alarm Color

<Alarm Time>time to activate alarm.

<Show Alarm Count>show total alarm times on

screen. Alarm Time(s)

<Show Alarm Rule>show the defined area on
screen.

<Save> save to enable.
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Mo Alarm Color

Rule ID

Rule Mame:

Event Set

Detect Mode

Alarm Color

Mo Alarm Calor

=

] Eveid

Scene Number |1

Scene Name  Outdoor

The Longest 5

Speed Dome 1

Static Tracking 2

Rule Clear
‘Perlmeber vl | Line Clear ‘
|1ntrusion hd ‘
Red
Green
V| Show Alarm Count
V| show Alarm Rule
Save
=
Enable Arithmetic  []Behavior Analysis  [¥]Linkage Tracking (V] Face Detection
[~ pemographics
Arithmetic [Intelllgent Tracking v
Limit  [UpLimit o) [ set |
/|Enable Limit
V|Enable Anti-blocking
Save
v Line Clear

| Items Abandon

[ show Alarm Count

[ show Alarm Rule

Save



(3)Event Set ---Items Lost

<Line Clear> remove the defined area on video.
<Alarm Time> time to activate alarm.

<Show Alarm Count> show total alarm times on
screen.

<Show Alarm Rule> show the defined area on
screen.

<Save> save to enable.

(4)Event Set ---Loiter

<Alarm Time> time to activate alarm.
<Sensitivity> bigger value, higher sensitivity.
<Min Distance> smaller value,higher sensitivity.
<Show Alarm Count> show total alarm times on
screen.

<Show Alarm Rule> show the defined area on
screen.

<Save> save to enable.

(5)Event Set ---Running

<Max Distance> <Min moving distance>

Set the max and min distance on screen to detect
the target object speed.

<Show Alarm Count> show total alarm times.
<Show Alarm Rule> show the defined area on
screen.

<Save> save to enable.

(6)Event Set---Crowd

<Line Clear> remove defined area.

<Alarm Time(s)> time to activate alarm.
<Sensitivity> bigger value, higher sensitivity.

<Show Alarm Count> show total alarm times.

<Show Alarm Rule> show the defined area on

screen.

<Save> save to enable.
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Event Set
Alarm Color

No Alarm Color

Alarm Time(s)

I

tems Lost

ea

[]show Alarm Count

[]show Alarm Rule

Event Set

Alarm Color

No Alarm Color

Alarm Time(s)

Sensitivity

Min Distance

Event Set
Alarm Color
No Alarm Color

Max Distance

Min moving distance

Event Set

Alarm Time(s)

Sensitivity

Save

Loiter

[]show Alarm Count

[]Show Alarm Rule

Running

[] show Alarm Count

[[]show Alarm Rule

Crowd

[]show Alarm Count
[[]show Alarm Rule

Save

Line Clear

Line Clear

Line Clear

Line Clear



(7)Event Set --- Parking

<Line Clear> remove defined area.

<Alarm Time(s)> time to activate alarm.

<Show Alarm Count> show total alarm times.
<Show Alarm Rule> show the defined area on
screen.

<Save> save to enable.

6.3.2.2 Panorama Tracking

(1) Check to enable the target channel

(2) Select <Panorama Tracking >

(3) Click <Save Scene> to start setting.

(4) <Arithmetic> show current arithmetic.

<The longest > set the longest tracking time (S)
<Speed Dome >set the height of speed dome(this value
should be the same as actually installation height) ,3m-
9m is suggested .

<Static Tracking > set the time for speed dome to wait
when target object is not moving.

<Limit> set the tracking region limit on screen.
(up/down/left /right)

(5) <Enable Limit> validate the limit set.

(6) <Enable Anti-blocking> enable to detect a wider
area when target object is covered.

(7) <Save> save to enable.

6.3.2.3 Face Detection

This function will enable speed dome to recognize
people’s face and snapshot and save face picture
automatically.

(1)Check <Face Detection>

(2)Click <save scene> to start setting

(3)<Max Face Size> <Min Face Size> setup target face
size percent in target region.

(4)<Sensitivity> setup detection sensitivity.

(5)<Run level> level 0-4, bulit-in programe level, please
keep default.

(6)<Face Snapshot> ON/OFF, when ON it will capture
the detected face picutre and save.

(7)<Draw Region> click to define a region on screen,
speed dome will only detect people’s face in this region.

(8)<Save> save to enable.
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EventSet | Parking

Alarm Color  Red

No Alarm Color  Green

Alarm Time(s)

["] show Alarm Count

] Show Alarm Rule

‘( Save ‘

Scene Number
Scene Name

Enable Arithmetic

Arithmetic

The Longest

Speed Dome

Static Tracking

Limit

Scene Number
Scene Name

Enable Arithmetic

Arithmetic
Max Face Size
Min Face Size
Sensitivity
Run Level

Face Snapshot

1
Outdoor

[“1Behavior Analysis

["] pemographics

Save Scene

Intelligent Tracking
5

1

2

UpLimit

Enable Limit
Enable Anti-blocking

Save

1
Outdoor

["]Behavior Analysis
["]pemographics

Save Scene

Face Detection

0
OFF

D Draw Region

Save

v Line Clear

[¥]Panorama Tracking [ ] Face Detection

v Set

[]Panorama Tracking Face Detection

30%

5%



6.3.2.4 Demographics

This function will enable speed dome to count the
number of how many people cross the defined line
on screen.

(1)Check <Demographics>

(2)<Mode> choose <vertical demographics> or
<bias demographics>

(3)<Max Target Size> <Min Target Size> setup
target people size percent in target region.
(4)<Sensitivity> setup detection sensitivity.
(5)<Draw Region> check to define a region on
screen, speed dome will only count number in this
region.

(6)<Save> save to enable.

6.3.3 Alarm Set

Setup VCA activation schedule.

(1)<Channel No.> select the target channel

<VCA Enable> Indicate the VCA status of the
current channel.

(2)<Rule ID> Connected to the setup VCA rules in
<Event > When select rule ID, it will bring out
setup information of <VCA Enable>, <Rule
Name> and <Event>.

<Enable> Enable the setting of <Schedule> to
setup the day and time of the VCA activation.
(3)<Schedule> Schedule alarms. 4 time periods
selectable in a day.

<Apply> enable the setting.

(4)<Link Type>

<Link Out> alarm output.

<Link Rec> activate recording.

<Link Snap> activate snapshot.

<Save> Save to enable setting.
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Scene Number

Scene Name

Enable Arithmetic

Arithmetic

Detection Type

Mode

Max Target Size

Min Target Size

Sensitivity

i
Outdoor

["Behavior Analysis
Demographics

Save Scene

Demographics

[“]Panorama Tracking [ | Face Detection

Vertical Demographics

I:] Draw Region

Save

Channel No.  [Channel

1

Scene Number |1

]

RueD |1

Rule Name

Event

Schedule (Wednesday

=)

(V] wed

Link Type  |Link Out

¥]
J

Channel No. [~

Al

30%
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|Enable
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6.3.4 Advanced

(1)<Channel No.> Select target channel
(2)<Scene Number> Select target Scene No.
(3)<Max Target Size> Set upper limit how
much proportion the Object occupy on the
screen for recognition

(4)<Min Target Size> Set lower limit

Note: PLEASE KEEP THE FOLLOWING ITEMS
AS DEFAULT VALUE TO AVOID ANY ERROR.
PLEASE ASK FOR HELP OF SPECIALIST IF
REVISING NEEDED.

<Integrate>

<Target combined>

<Background Update>

<Foreground Max>

< Foreground Min>

<Target Confirmed>

(5)<Enable>

(6)<Save> save to enable.

6.3.5 Cruise Set
(1)Timed Cruise
Enable the speed dome to switch between
different defined VCA functions, time interval

range from 30~3600 seconds.

(2)Scheduled Cruise
Set valid time period for each defined VCA

functions.
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Channel No. [Channel 1

Scene Number [ 1

Max Target Size
Min Target Size {1
Integrate
Target Combined
Background Update
Foreground Max {1
Foreground Min {1

Target Confirmed

[T]Enable

Save

(®) Timed Cruise (O scheduled Cruise
Ho.  Scene No.
i1 1
02 3
13 2
04 |« bt
Save
() Timed Cruise (@) Scheduled Cruise
Ho.  Sceme No.
01 1
2 |z v

Save

Scene Name

Qutdoor

Test

Scene Name

Qutdoor
Test

30%

3%

Add Delete

Retention Tine(s)
30
30
100

Add Delete

Start Time End Time
23:.00 12:59
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6.4 OSD

6.4.1 0SD

Channel Name

(1)<Channel Name> Input channel name, then it
will show on screen.

(2) <Customize Position> drag <Channel Name>
to the target position on screen.

(3)<Color> Choose your favorite color.

Date

(1) <Date> Display date on screen.

(2) <Show Week> Display week on screen.

(3) <Customize Position> drag <Date> to the
target position on screen.

(4)<Color> Choose your favorite color.

Additional Text

(1)<Additional Text> 5 areas available to put
additional text on the screen.

(2) <Customize Position> drag <Date> to the
target position on screen.

(3)<Color> Choose your favorite color.

0SD Size
<Adjust-Self> Edit OSD size.

<Save> Save all settings.

6.4.2 LOGO

Add LOGO picture on screen.

Notes logo picture format must

be .bmp, and must be follow the size.
<LOGO File>,<Browse> to select logo
picture, and<Upload>

Notice Device will restart after upload
(1)After restart, select<Enable> to show the
logo on screen.

(2)Enable<Customize coordinate Pos> to
put the logo on the target position on screen

where you click.
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Chamnel 1

[¥] Channel Mame |Channel 1 |

[[] Customize Position Color

Date |z014j0zi07 v
[[] Customize Position Color
[ shiow week.
(%) 24 hours ()12 hours

Additional Text | 1 £

[[] Customize Position Color

05D Size [ adust-gelf |

Save

LOGO Filef*, brp) | |l Browse H Upload ]

[JEnable
[ custamize coardinate(dick video window)Pos
Requirements on the image format:

1.The bitmap depth must: be 24.
2.The size shall be less than 200%200, and the height and width shal be multiple of 4,



6.4.3 Video Cover

Add up to 4 cover areas on the screen.
(1)<Channel No.> Choose target channel.
(2)<Draw Region> Check to enable.
(3)Draw cover area on screen

(4)<Clean Area> Delete all cover areas.

6.5 Storage Management

6.5.1 Record Policy

Setup recording schedule.

(1)<Channel No.> Choose target channel.
(2)<Record Status> Display current record status.
(3)Select recording type(multiple-choice)
<Manual Rec> Check to start recording.

<Alarm Rec> Recording will be activated by
alarm.

<Task Rec> Timing recording, 4 time periods
settable for one day.

(4)<Offline Video> When it is ON, the device will
follow the schedule of <Task Rec> when offline.

(5)<Save> Save.

6.5.2 Pre-recorded Alarm

<Pre-recorded Alarm> record before alarm, or
continue to record after alarm.

(1)<Channel No.> Target channel.
(2)<Pre-recorded Alarm> Check to enable.
(3)<Pre-record Time> Record before alarm.
(4)<Record Delay> Continues to record after
alarm.

(5)<Save> Save.

6.5.3 Storage Set

<Pack by time> Pack the record files by time.
<Free Disk> Pack the record files by size.
<Strategy> Select how to handle the record files
when the disk is full.

<Stop Rec> Stop record new files.

<Cycle Del> Delete the earliest record files.
<Cycle Del (Except Alarm)>

Delete the earliest record files except event record

files.
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video Cover

ChannelNo. | Channel 1 Major M|

[Joraw Region

Clean Area

Record Palicy

Channel o, | channel 1 &

Record Status

[JManual Rec
[] Alarm Rec
[JTaskrec

Schedule

Copy To Clan

Csen Cvon e Cwed  Clthe R Clsat

Offie videa | OFF

- | Prompt videa recording with Internet disconnected, a1

Save

Pre-recorded Alarm

Channel Mo, | Channel 1 b |

Pre-recorded Alarm

Pre-record Time (5-15)s |ID v|

Record Delay (10-60)s | 10 “ |

Save

Storage Set

Storage Palicy

@Packby Tme 30 | to~sarin

Free Disk |900 | (>=200ME

Strabegy |Cycle Del 3 |

Save



<Save>

6.5.4 Snapshot Set

(1) <Channel No.> Select target channel.
(2)<Timing capture> Enable timing capture
(3)<Interval(s)> Set how much internval times
between two snapshots.

(4)<Link FTP>snapshot and upload to FTP server.
(5)<Link Email>snapshot and send to target email.
(4)<Save>

6.5.5 Disk Information
<Initialize Disk> format the disk

6.5.6 Network Storage

(1)<Device No.> Select disk.

(2)<Status> Show current disk status information
(3)<Usage> Shows purpose of disk.

(4)<IP Address> Setup [P address of <Network
Storage>.

(5)<Mapping Path> Setup disk path of mapping.
(6)<Total Size(M)> Shows used and total capacity of
the disk.

(7)<Save>

6.6 Network Management

6.6.1 Cable Network

<DHCP> check to enable DHCP server will
automatically allocate IP address for devices.
<IPv6> Display IPV6 address and subnet mask.
<MTU> Maximum Transmission Unit, range from
500~1500, default value is 1500.

<Ethernet Rate> Select mode and rate of Ethernet
card, default mode is <Automatic Detection>, speed
unit is MB.

Notes: Devices will restart after change <Ethernet

Rate>.
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Snapshot Set

Channel Mo, | Channel 1
Timing capkure | Disable
Intervalls)

Capture Link. []Link FTP ] Link Emnail

Save

Net Storage

Device Mo, 1
Stakus
Usage
IP Address i} . i} . a

Mapping Path  |/nfs

Save

Total Size(M) [

Free Space(0.00G) Taotal Size(0.00G)

Cable Network
[JoHcP
IPv4 Address 192 . 1o . 1
IPv4 Subnet Mask 255 . 255 . 255
IPv6 Address
IPv6 Subnet Mask
Gateway 192 . 168 . 1
DMS 192 . 165 . 1
[T 1500

Ethernet Rate(lM) | Automatic Detection

Save
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6.6.2 Registration Center
Keep same settings as what you register in DDNS

website (www.myvideo.com).

6.6.3 Network Service
DDNS
Keep same settings as what you register in DDNS

website(suggested: www.myvideo.com).

FTP

Make sure to insert the memory card.
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» Dome Set

=)

» 05D

b Storage Management
 Netviork Management

Cable Network

Network Service

TP Fiter
P User Management
b alarm Management
b PTZ Management

¥ Advance Set

Registration Center

Server tame WSS

P [9zLeELL
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Passiord  [eee

Password Confirm

DlFw
b | PPPoE
| NTP
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PPPoE

Check to enable PPPoE function, enter User

name and confirm password.

NTP

<NTP Server> enter server address.
<Port> enter NTP server port.

<Interval> update interval.

Others

b sudio video Set.
b Dome Set

b vca

b osD

Network Service

> oons
e
> PPPoE
e

e

Port (123

Intervaih) [0

b Audio Video Set

» Dame Set

=

» o>

b Storage Management
¥ Metwork Management.

Cable Network

Netwark Service:
TP Filter

¥ User Managemert
b Alarm Management
¥ PTZ Managemert

¥ Advance Set

Registration Center

Network Service

> DoNs
BlFTe
b Frroe
Bl
] Other

[ upnP Enable

[shmP Enable

HTTP Port (20

HITPS Port 443

Set Http and Https port, Enable UPnP and SNMP functions.

6.6.4 IP Filter

Blacklist

¥ fuxdi idso 56t

» Dome Set

e

b o

¥ Stonage Menagemert

 Hetwerk Management
Cable Network
Regstration Censer
Netwiork Service
ke

¥ User Mansgement

¥ Alarm Managemert

¥ P2 Managemert

b Bddvarce Set

TP Filter

@ alow 5l O sl e Folowing [P

P Delete.

O ok the Folloning IPs

Save

Status

User want to block some IP address, select<Block the Following IPs>, input the block IP address

and<Add>,<Save>.Max to add 16 blacklist IP address.

Caution: Please don’t add your own IP address in blacklist, otherwise you will not be able to

login.
Whitelist

User want to allow only some IP address, select <Allow the Following IP>, input trusted IP
address, <Add> and <Save>. Max to 16 whitelist IP address.

Caution: Once enable the whitelist function, please make sure to add your own IP address in

whitelist, otherwise you will not be able to login the device.
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Cancel blacklist or whitelist

Anytime click<Allow All> and <Save> to cancel all the blacklist and whitelist.

Note: Please restart device after setup blacklist or whitelist.

6.7 User management

6.7.1 Add User

<User name> add user, only English letter and figure
are available.

<Password> only English letter and figure are
available.

<Authority>:

Browse: Can only watch the videos.

browse+ control: Watch video and control PTZ.
browse+ control+ set: Allow all operation except
user management.

Administrator: All operations available.

6.7.2 Modify password

Select the user you want to modify in the user list,
click <Modify Pwd>,input the old password, new
password, password confirmation, then
click<Modify>.

6.7.3 Delete User

Select targeted user in user list and click [Delete]
to delete.

6.8 Alarm Management

6.8.1 Alarm Input

IP Camera alarm input has port1~8, alarm mode
include closed circuit alarm and open circuit alarm.
<ON>is closed circuit alarm.

<OFF>is open circuit alarm.

<Link Out>/<Link PTZ> activate alarm device or PTZ.
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6.8.2 Alarm Output

Alarm output has port 1~2. Alarm Output
<ON>is closed circuit alarm. ouperor [ 3
<OFF>is open circuit alarm.

Made Set |ON v|

[]set Motion Detect Area

6.8.3 Motion Alarm -4

(1)<Set Motion Detection Area> Check to draw area on o l;‘d;;m |« [om v}

screen. e B
(2)<Clean Area> Clean drawn area. = [ |~ [mo |
(3)<ICR-Sensitivity> set detection sensitivity, range from 0- Do Di:” O Owed Ome Eri Osa
100, 100 means the highest sensitivity. tokTes. [unkon -]
(4)<Schedule> setup alarm arm schedule. ST e e

17 18 19 20 21 22 23 24 25 26 27 26 25 30 31 2

(5)<Link Out> set alarm activation.

Channel 1

6.8.4 Lost alarm Lot e

CrarmelNo. | chareel ¥ Blenie

Alarm when video lost.

Schedule | Friday v

(1) Check to enable lost alarm for target channel.

(2) <Schedule> Setup alarm arm schedule.

Corlo Ca

(3) <Link Type> Link PTZ/no link. Dan Owe D Owed Ot B Do
(4) <Link Channel> . m,,_. .

(5) <Link PTZ Type> no link/preset position/pattern/auto T :

tour. =
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6.8.5 Cover Alarm

Alarm when camera lens is covered.

» Audio Video Set
b Dome Set Cover Alarm
b vCA
b oo Channel N, | channel 1 v endble
b Storage Management 1< 7 24
¥ Network Management
b User Managsment sehecle | Frcay v‘
- o EETTE| - EETTE
Motian Alatm
O [EEE - (-
Lost Alarm
CopyTa  [Jal
Csun Cmon Crwue  [lwed e [ [Csat Apnly
Email Alarm
Link T:
Alarm Server e Lekerz |
b PTZ Management Link Channel | charne! 1 ~
b Advance Set
Link PTZ Type \NU Link v\
Muraber

6.8.6 Email Alarm

(1)<Email Alarm Enable> check to enable
sending email after alarm.

(2)Set sending email information:

<SMTP server> <SMTP port><Email
Account><Email Password>

(3)<Email Mode>

(4)Input receive email address, support up to

4 email address.

6.8.7 Alarm Server

Set alarm server’s IP address and port

» Audio video Set

» Dome Set

» vca

» Gsm

» Storage Management

» Network Management

» User Management

~ Alarta Management
Alarm Input

Alarm Output

Email Alarm

[CJEmail Alarm Enable

sttpserver [0

smip part [z

Email Account [0

Emall Password [«

Emal Mode | off

» Storage Management

Motion Alarm
Lost alarm Email subject [0 ]
Caver Alarm

Main Email Address [0 |

Alarm Server Email Address 1 [0 ]

» PTZManagement i addressz [0 ]
» advance set

Emall Address 3 [0 ]

» audio viden Set

» Dome Set Alarm Server

=Y

» 0D Alarm Server | 255 255 255 =

number,

¥ Network Management
¥ User Management
~ Alarm Management
alarm Input
alarm output,
Mation Alarm
Lost Alarm

Cover Alarm

Emall Alarm

b PTZ Management

b Advance Set

Port [0
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6.9 PTZ Management and Control

PTZ management mode: <Serial Port Set>and<Protocol
Set>

<Serial Port Set>:

<Port Name>,<Baud Rate>,<Parity>,<Byte Size>,<Work
Mode>

<Protocol Set>:

<Channel>,<Port Name>,<Protocol>,<Address>

6.10 Advance

6.10.1 Local set

Serial Port Set

Serial Part Set

Port Name

Baud Rate

Parity

Byte Size

Work Mode
Protocol Set

Channel

Fort Name

Frotocal

Address

[come ¥

3800 v/
[None: v
e |
[Protocol Made v
s o]
|coma v
|pove_peLcop v

(1)<Showing frame-rate and bit-stream information> check to display frame rate and bit stream

on video.

(2)Set the save path of record files, snapshot, clips and download files.

(3)<Protocol Type> TCP, UDP or multicast.

(4)IP camera has only one channel, user can choose major stream or minor stream.

[ 5howing frame-rate and bit-stream infarmation

Save record files ko |d:\NetvideoBrowser'lRecordFiIes'l |
Save snapshots in live view b |d1\NEtVidEUBFUWSET\CGDWEP‘ES‘. |
Save snapshots when playback to |d:\NetVideoBrowser\P\aybackPics\ |
Save clips ko |d:\,NetVidenBrnwser'lP\ayhackFiles'l |
Save downloaded files to |d:\Net\iideUBruwsEr\Duwnluadeles\ |

Pratocal Tvpe |TCP v |

6.10.2 System setting

(1)<System Time> Set time zone and time
synchronous.

(2)<SystemInformation>Display information of
CPU,Memory and FLASH.

(3)< Version Information >Display <SDK Version>,

<Kernel Version>, <Web Version> and<Factory ID>.
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el 1
Channel 1
14

Chamnel 1

Language and
Timezone

System Time  2014/02/07 16:34:41

Region | GMT+05:00 ¥

Daylight-Saving Time ] Enable

Start Time  Jan First Sun o0 o'dock
End Time  Jan First Sun oo o'clock
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6.10.3 System Maintenance
System maintenance includes <Equipment

Control>and <Version Upgrade>.

System

(1)<Equipment Control> Equpment Conbel
<Restore> Reset to factory default.
<Reboot> Reboot the device. Version Lpgrde
Uparade File  (*.bimor(=.box)

(2)<Version Upgrade> upgrade new firmware.
(firmware format: .box/.bin) Upgrade process
normally needs a few minutes until indication for

completion.

Caution: Please strictly follow the instruction by technical specialist for firmware upgrade.

Register Server 192 . 188 . 1 .1

Port 10102

6'10'4 Access Platform Heartheat Server 192 . 168 . 1 . 100

PU set user can set the IP address and port number port [0tz

of<Register Server>,<Heartbeat Server>,<Alarm Femer @ L W

Port 2122

Server>and VSP’s port number and VAP’s port number.

Device ID

<Channel No. >support<Auto Filling Setting>function. DeviceName
¥sP Part [goon
WAP Port 9000
Access Pass
PU set support [SIP] protocol setting. Chamaitn, [chaw 1 3
Channel [0 |0
® spset
Server IP 0 . v} . a . o
Server Port a
Server ID
Device ID
User Name
Password
RegValidity 0

Keep-glive a
Heartbeat Interval 0

Heart Rate a

[T Need to Register

IP cameras support onvif V10, user can choose “enable”.

[¥) Platform Enabled

Platform List [onvif 7] [ZlEnable
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Chapter 7 Simple Problem-solving Methods

symptom

Possible causes

Solutions

Power on no action,

No images,

Machine is not self

checking

Power supply is damaged or not

enough power

Replace the power supply

Power cable fault

Corrected

Line problems

Troubleshoot line, measure IP speed dome’s

voltage

Self action properly,
but can’t ping

Network line or switch damaged

Test by IP speed dome connect to PC directly

IP speed dome’s IP address and PC’s
[P address aren’t in same network

segment

Change IP address to insure they are in the same

network segment and aren’t conflict.

Ping is working
normally, but can’t

login

User name or password error

Check user name or password

Port number error

Check port number

Login account more than limit

Disconnect other client host

No video after login

Login account more than limit

Connect video by proxy server

Camera is damaged

Check log record

Parameter setting error

Restore the default parameters

Image is not stable

[P address conflict; MAC address

conflict; broadcast storm

Check network setting

Network line problem

Check network line

Image is not stable,

delay,

PC performance isn’t enough

Check CPU utilization, reduce code stream or

resolution

Frame rate is low

Change frame rate in more than 20

The network bandwidth shortage

Replace the gigabit switches

Decoder’s performance isn’t

enough

Change decoder
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IP Speed dome can’t

be controlled

Serial port Settings error

Check and change serial port number to “COM2”

Protocol, Baud rate, address error

Check IP speed dome’s protocol, baud rate and

address

I[P  Speed dome
restart again and

again

Power supply isn’t enough, voltage

isn’t stable

Measure [P speed dome’s voltage to insure
stability

PPPOE dialing failed

Check and change dialing parameter

Camera is damaged

Replace the camera

Parameter setting error

Restore the default parameters
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Chapter 8 After-sales Service

The HD Network IR speed dome products, the company offers one-year warranty. Product
warranty, the company provides a free service, but if any of the following circumstances, is charged

fee for material costs work:

® Do not operate in accordance with the provisions of the manual
® The speed dome damage caused by a case of the lightning strikes, fires and irresistible natural
disasters;

®  Matching problems arising from poor design to other manufacturers products cause damage;
Company statement

® As we continue to introduce new technologies and product specifications are subject to

change without prior notice.
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Appendix I Lightning and Surge

Outdoor Dome Camera need to consider lightening, anti-surge, on the premise of ensuring

electrical safety, may take the following measures:

Signal transmission lines and high voltage equipment or high voltage cables must be at least
50 meters distance between;

Try to choose outdoor wiring along the eaves line;

For open field must be sealed steel tubes buried cabling, grounding and steel pipe, the
absolute prohibition of the use of overhead wiring;

In areas of severe thunderstorm or high-voltage area (such as high-voltage substations),
lightning protection equipment, as well as for additional installed power must be taken
measures such as installing lightning rods

Outdoor lightning protection and grounding design of devices and circuits must be combined
with building mine requires unified consideration and in accordance with the requirements
of the relevant national standards, industry standards;

System must be equipotential earthing. Earthing system anti-interference must be met and
the dual requirements of electrical safety, and shall not be mixed with strong power network
neutral wire shorted or separately when grounding, grounding impedance less than 4 ohms,

ground wire cut-area must be not greater than 25mm?2 lines shorted
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Video surge arrester

Telecommunication
surge arrester

Power surge arrester

/

Grounding conductor resistance /
no more than 4 ohms ,7

/I

Steel tube protector ,’

Surge arrester

45°

Speed dome must be
installed within the surge
arrester below 45 degree
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Appendix II::Hoisting construction Guide

Base made from silica gel
for waterproof

Base made from silica gel
for waterproof

VC plastic pipe

]
/l \. PVC plastic pipe
ed dome line across inside of

\
@? \
Pendent mount bracket outdoor waterproof
construction scheme |
]
]
Speed dome line across B
inside of pole
/ \ -
@? \

Pendent mount bracket outdoor waterproof
construction scheme Il
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Customer homemade bent pipe bracket

7
/ \ Speed dome line across L

inside of pole

/¢

Pendent mount bracket outdoor waterproof
construction scheme |lI

Customer homemade bent pipe bracket

—\
\

A\

Speed dome line across  [] :
inside of pole

4

Pendent mount bracket outdoor waterproof
construction scheme IV
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